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Introduction to Cyber Check Suite 

 

Cyber Check is a forensic analysis tool developed by C-DAC, 

Thiruvananthapuram, for analysing the Evidence file acquired by 

the Imaging tool True Back (Forensic Imaging tool developed by 

C-DAC, Thiruvananthapuram). It is also capable of analyzing raw 

images generated by other Cyber Forensic Tools. MD5 Hash 

Algorithm is used in Cyber Check for verifying data integrity. 

When loading the software, it performs a self-integrity check on 

itself. If the Cyber Check Executable is corrupted, it will display a 

message notifying that Cyber Check Executable is corrupted, 

cannot continue with analysis. Further loading of the software will 

be terminated. It should be noted, the Cyber Check do the self-

integrity check while loading the software itself. If the software is 

corrupted beyond loading it, it may not be possible to load the 

software at all. In this case, the software may be considered as 

totally corrupted. 
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The main features of Cyber Check are 

 

 Standard Windows application on Windows, XP and Vista. 

 Self-Integrity check 

 Minimum system configuration check. 

 Analyses evidence file containing FAT12/16/32, NTFS, CDFS, 

 Linux EXT2/3 FS, Unix FS2 (Free BSD), Solaris and Reiser file 

systems. 

 Support for GUID Partitioning (GPT) table. 

 Facility for analyzing evidence files having DD and Encase formats. 

 Facility for analyzing multiple evidence files. 

 User login facilities. 

 Creates log of each analysis session and Analyzing officer’s details. 

 Block by block data integrity verification while loading evidence file. 

 Explorer type view of contents of the whole evidence file. 

 Display of folders and files with all attributes. 

 Sorting of file attributes up to 5 levels. 

 Show/Hide system files. 

 Text/Hex view of the content of a file. 

 Picture view of an image file. 

 Gallery view of images. 

 Graphical representation of the following views of an evidence file. 
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o Disk View 

o Cluster View 

o Block View 

 Timeline View of 

o All files 

o Deleted files 

o Time anomaly files 

o Signature Mismatched files 

o Files created within a time frame 

 Single and Multiple Keyword search. 

 Search with GREP expressions. 

 Search with Unicode characters. 

 Extraction of Disk, Partition, File and MBR Slacks. 

 Exclusive search in slack space. 

 Data recovery from deleted files and slack space. 

 Exporting files, folders and slack content. 

 Exporting folder structure including file names into a file. 

 Exporting files on to an external viewer. 

 Extraction of unused unallocated clusters and exclusion from search 

space. 

 Extraction of lost clusters. 

 Exclusive search in data extracted from lost clusters. 
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 In-place or zero storage file carving facility from lost clusters, 

unallocated clusters, disk slack and within a file. 

 Exporting Swap files. 

 Exclusive search in data extracted from Swap files. 

 File search based on hash value. 

 File search based on extension. 

 Exclusion of system files from search space. 

 Multiple sorting based on file attributes. 

 Local and Network preview of storage media 

 Partitions previewing facility. 

 Book marking facility for data, files and folders 

 Mailbox viewer 

 Registry viewer 

 Expansion trigger at different levels of folder structure 

 Recovery of deleted partitions 

 Recovery of formatted media 

 Facility for analyzing raw images 

 Identification of Password protected files MS office files 

 Identification of overwritten files 

 Unicode support 

 Indian Language support 

 Virtual Keyboard for entering Unicode characters. 
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 Support for dynamic disk analysis 

 Customized hash set library creation 

 Support for scripting 

 Predefined filters for analysis. 

 Facility for user defined filters. 

 Customization of File Signature Library 

 Facility for extracting deleted mails from .dbx files. 

 Identification of steganographed files. 

 Facility for viewing nested ZIP file listing. 

 Extract Recycle Bin files 

 Internet History Viewer 

 Facility to view metadata of Microsoft office files 

 Data Carving from Unallocated & Lost clusters, Disk Slack 

 Index based searching 

 Anti-forensics detection 

 Generation of analysis report with the following features. 

o Complete information of the evidence file system. 

o Complete information of partition and drive geometry. 

o Hash verification details. 

o User login and logout information. 

o Exported content of text file and slack information. 

o Includes picture file as image. 
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o Customization of report 

o Save report. 

o Print report. 

 Support to load MobileCheck 2.0 images 

 Mount image to drive 

 Windows 7Hibernate File Analysis 

 Browser Forensics 

o Internet Explorer 

o Google Chrome 

o Mozilla FireFox 

 Windows 8 Forensics 

 GPS information extraction from JPEG images 

 Memory Analysis 

 Expand the content of TAR files 

 Identifying Document languages 

 Log and Event File Analysis 

 Integrated virtual environment Vmdk and Vhd file analysis 

 "In built viewing facility for Video files like MP4, 3gp, Fly, WMV, 

Divx, Avi" 

 Prefetch Analysis for WindowsXP/7/8 

 Removal of Evidence 

 Integration of F-RAN 

 Integration of F-Tex 

 Known File Filters updation 

 Enhancements on volume shadow copy Analysis 

 Gallery Selection with SHIFT Key 
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Data Recovery and Analysis Tool 

(Note: The exercise may be carried out on the evidence file) 

  

 

Task 1: What is the procedure for creating a new user? 

Solution:  Run CyberCheck6.0 > File > New >> User Setting 

Window Click "Add User" 

(Default password of Admin user = cyber) 

 

Task 2: How do you load a particular evidence file for analysis?  

Solution: Select File New or click on New  tool bar button 

 

Click the Browse button for specifying the Evidence File Name. 
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 A File Open dialog box will be displayed for browsing and selecting 

the desired image file. 

 

 

 

 Select the image (Evidence File .000 or .P01) and press the Open 

button 
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 Then the Evidence file path is loaded in the Log in window. Click 

OK button 

.  

 

 

Task 3: What are the default contents in the CyberCheck report? 

How do you see the number of partitions available in an evidence 

file? Note down the type of partitions available and total sectors 

occupied by each partition.  

 

Solution: Default contents in the CyberCheck report are  

 

 Complete information of the Evidence file system 

 Complete information of the partitions and drive geometry 

 Hash Verification details  

 User login and logout information 
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Partition details available in the evidence file can be viewed from 

the Report tab. 

 

 

 

Total sectors occupied by each partition can be viewed from the 

Partition Details Table in the Report tab. 
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Task 4: How do you verify the hash value of an evidence file?  

Solution: Select Options>Hash Evidence menu item from the main 

user interface of CyberCheck 

 

Task 5: How do you start a search process for a particular key 

word?  

Solution: Select Keyword tab from left pane 
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 Click Add Keyword option from the Keyword menu. This 

sub-menu item will become enabled, only when in the 

Keywords tab in the left pane. 

 

 

 

Or Right click Keywords and select Add Keyword. 
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The fourth item (item with key symbol) in the toolbar also has the 

same functionality. 

On clicking Add Keyword option a new dialog box appears. Add 

the specified keyword in Enter Text box. Hex View shows the hex 

value of the entered text. Keyword to be searched can be made 

Case sensitive, Unicode or Grep type. 
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After entering the keyword, click OK button, the entered keyword 

will then be added to a list of keywords to form a Table of 

keywords. To search for multiple keywords, press Add Keyword 
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button. To search for a particular keyword added, check the 

appropriate check boxes in the table. 

 

Go to Search option, and select Keyword Search or click the 

Binocular icon in tool bar  
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Select the keyword(s) to be searched from the table of keywords. 

Click on Entire Case to search through the entire folders and files 

of the evidence file. To search in a particular file, click on the 

Selected Only radio button. (Select the desired files and folders 

before selecting Search Keyword Search menu item).There are 

other options like Files and  

 

Folders, Used unallocated clusters, lost clusters and Slack for 

limiting the search space. Press Start Search. 

 

 

A progress bar is shown to show the progress of searching. To 

know the number of hits, place the mouse pointer on the progress 

bar for some time. A tool tip will appear indicating the number of 

hits occurred at that time. On completion of the search process, a 

message box showing the total hits and elapsed time is displayed. 
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Click the ‘yes‘button, to go to the currently added session in the 

search pane. 

 

 

Task 6: How can you view the search hits of a search process? 

Solution: Search results displays files that contain the searched 

keyword. The keywords are highlighted in green with selected 

file’s keyword in the text viewer in the bottom pane. Search tab in 

the left pane displays the session number and the number of hits 

for that keyword. 
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Task 7: What are all the items that can be book marked for later 

use? 

Solution: The Bookmarks tab view provides three options namely: 

 Folders - This contains information regarding all 

bookmarked folders 

 Files - This contains information regarding all 

bookmarked files. 

 Selected Data - This contains information regarding the 

data selected for bookmarking during the analysis  

 

 To bookmark a file, select the desired file from the Table View, 

right click and select Bookmark File from the context menu. 
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Bookmarking a file can also be done by selecting Bookmark> 

Bookmark File from main menu. 

 

 

On selection, a message for confirming the process will be 

displayed. Click Yes button 
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A dialog box will be displayed for entering comments, if any, to 

be attached with this file. Enter appropriate comment and press 

OK button for bookmarking the selected file. 
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The bookmarked file now gets added up under the Bookmark tab 

in the left pane 

 

 

Task 8: How do you add a book-marked item into the report?  

Solution: Two Methods are there: 

a.) Go to Bookmark Tab view >> Right Click bookmarked 

items >> Append to Report 

b.) On Table Tab view >> Right Click the Folders/Files >> 

Append to Report 

 

Task 9: How can you view the entire pictures available in an 

evidence file?  

Solution: The Gallery view in the Right pane is a quick way to 

see the entire pictures available in a folder as thumbnail views.  

For viewing pictures select a folder. 
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Select the Gallery View tab from the right pane. All the picture 

files available in that folder will be displayed in the gallery viewer. 
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To see the enlarged image –Select the needed picture, which will 

be displayed in the Picture viewer in the bottom pane. 
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Task 10: How can you see a signature-mismatched file? 

Solution: Option menu >> Check File Signature. 

Those files, which have a signature mismatch, will display a status 

“Y” in the SM (Signature Mismatch) column in the Table View. 

 

 

 

Task 11: How can you search for files, which are created within a 

particular time frame? 

Solution: In the Timeline dialog select the Date and pick the 

appropriate From and To date and click the Show Chart button. 
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Display the files, which are created within a time frame in the 

Timeline chart. 
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Task 12: How do you perform a search for a particular key word 

in unallocated cluster area? 

Solution: Select Keyword tab from left pane 
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Click Add Keyword option from the Keyword menu. This 

sub-menu item will become enabled, only when in the 

Keywords tab in the left pane. 

 

 

Or Right click Keywords and select Add Keyword. 
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The fourth item (item with key symbol) in the toolbar also has the 

same functionality. 

On clicking Add Keyword option a new dialog box appears. Add 

the specified keyword in Enter Text box. Hex View shows the hex 

value of the entered text. Keyword to be searched can be made 

Case sensitive, Unicode or Grep type 
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After entering the keyword, click OK button, the entered keyword 

will then be added to a list of keywords to form a Table of 

keywords. To search for multiple keywords, press Add Keyword 

button. To search for a particular keyword added, check the 

appropriate check boxes in the table. 
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Go to Search option, and select Keyword Search or click the 

Binocular icon in tool bar  
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Select the keyword(s) to be searched from the table of keywords. 

Click on Entire Case to search through the entire folders and files 

of the evidence file. To search in a particular file, click on the 

Selected Only radio button. (Select the desired files and folders 

before selecting Search > Keyword Search menu item). 

Click the Option options "Used unallocated clusters". 

 Press Start Search. 

 

 

 

Task 13: How can you exclude system files from the keyword 

search? 

Solution: Repeat Question 12 Hints, and Tick the option "Ignore 

System Files" in Search Options window. 
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Task 14: How can you search for files based on file extension? 

Solution: Select Search option from the main menu and then File 

Search 

 

 

There are options to search document, image, audio and video 

files.  On selecting these options corresponding file extensions are 
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added in to the File Extension box.  Any other extension required 

can be added in to File Extension edit box. By default the Entire 

case file is searched, search can be specified to Selected Files also. 

 

 

 

After specifying the File Types to be searched, click the OK 

button.  On clicking the OK button, a progress bar will be 

displayed to indicate the progress of the search process. A message 

box will be displayed after the completion of search process. Click 

Yes to view the search results 
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The files that match with the specified extensions will be 

displayed. Click on a file to view the content in the bottom pane. 

This set of files will be available in the File Extension folder in 

the Search Tab view, till it is replaced by the result of another File 

Search. 
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Task 15: How can you find out the hash value of a file from 

CyberCheck?  

Solution: To take the hash values of a selected file, select the file 

by clicking the check box of the desired file and choose the 

Options >> Hash Files from the main menu. 
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Choose ‘Selected’ option in the dialog box that appears and the 

hashing algorithm. Click OK. If the desired file is not chosen and 

‘Selected’ option is clicked a message appears-No file(s)/folder(s) 

selected. Click on the check box near file(s)/folder(s) to select the 

desired item(s)” 
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On completion a message appears- “Hashing of Selected file(s) 

completed”. Hash value of each file will be added as an attribute of 

the file. This can be viewed in the Table view at the end of the 

attribute bar under the column MD5/SHA1 or SHA2 Hash Value 

in the right pane column. 

 

Task 16: How can you search for files with same hash value? 

Solution: On "Table View Tab " Right click any file >> Copy 

Hash Value . 

Then Select Search option from the main menu and then File 

Search 
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In "File Search" window dialog select the option "File Hash" and 

select the HASH algorithm. Type or the Paste the Hash value in 

Text box provided. 

 

Task 17: How can you view all the deleted files in an evidence 

file? 

Solution: Goto "Filter" menu >> Click Deleted files. 

 

Task 18: How can you recover a deleted file? 

Solution: Select the desired file from the list of deleted files by 

checking the box of the appropriate file  
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Either right click the desired file and select export or select 

Export|File/Folder 
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Specify a path into which the selected item is to be exported.  

 

 

Click OK, the item will be exported into the specified path, a 

message-“Successfully exported” will be displayed showing the 

path to which the file is exported. 

 

Task 19: How can you recover a deleted folder? 

Solution: Select the desired folder from the list of deleted files by 

checking the box of the appropriate folder. 
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Either right click the desired folder and select export or select 

Export|File/Folder 
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Specify a path into which the selected item is to be exported. 

 

 

 

Click OK, the item will be exported into the specified path, a 

message-“Successfully exported” will be displayed showing the 

path to which the file is exported 

 

Task 20: What is the information available in Block view?  

Solution: Block view is the block-by-block representation of the 

entire evidence file. Select View|Block View to display the blocks.  
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The blocks are displayed in three different colors representing: 

Blue - Used Blocks, White – Unused blocks and Red – 

Mismatched blocks. Information like total blocks, sectors per 

block, last block sector, used blocks, unused blocks and the 

number of blocks with hash mismatch are shown in the boxes 

provided. When a block is selected in the block view the 

corresponding block number, sectors in that block, seize hash, 

source hash, image hash and analysis hash are displayed. 
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The selected block will be highlighted as a green square in the 

block view. 

 

 

Task 21: How do you view the sectors allocated to a particular 

file? 

Solution: To view the sectors allocated to particular file, select the 

file and click the Disk view in the bottom pane. The blocks 

highlighted in white are the sectors allocated to the selected file. 
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Task 22: How do you view the clusters allocated to a particular 

file? 

Solution: Select the particular file and then click the Cluster view 

in the bottom pane. The blocks highlighted in white are the clusters 

allocated for the file. 
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Task 23: How do you view the cluster chain of a particular file? 

Solution: Right click any file in Table view >>  View Cluster 

Chain or from View menu >> Cluster chain 

 

Task 24: Add a picture file into the report and observe what 

happened in the report?  

Solution: To add a picture into the report, select the desired image 

file and either right click and ‘Append to Report’ or select the 

option from the Report menu in the main menu. 
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 A confirmation message appears, click yes. The next dialog asks 

whether to append the Content, Slack or Both. Select the Content 

option to just add the image file only. 
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Enter a comment and then OK.A message-Item successfully 

appended to report appears. Take the report tab from the middle 

pane. The report shows the details of the appended image file such 

as file name, extension, logical size, starting cluster, accessed date, 

whether deleted or not etc. 

 

 

 

Just after the file details of the image file, the image is displayed in 

the report. 

   

Task 25: How do you start partition recovery?  

Solution: To recover the deleted partitions, select 

Recovery|Partition Recovery 
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Select the desired option. In the Best option each and every sector 

in the evidence file will be scanned and in the Fast option, only 

sectors with sector number, as multiple of 63 will be scanned. 
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Click OK to start the recovery process, the progress is shown in the 

progress-bar. The number of partition(s) recovered is displayed in 

a message box. The recovered partition(s) will be displayed below 

the existing partitions in the Probe view.  Their names start with 

"Rec-".  For example, if two partitions have been recovered, then 

the first partition will be shown with the name Rec-1 and the 

second one with the name Rec-2.   

 

 

 

To see the files & folders of recovered partition(s), click on the "+" 

symbol near the partition name (like that of an existing partition). 

 

Task 26: How do you start format recovery?  
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Solution: Format recovery recovers the formatted partitions from 

the evidence file. Select Recovery|Format Recovery menu item 

from the main menu. 

 

 

 

All the available partitions are displayed for selecting the 

partition(s) to recover. Select the desired partition to recover by 

ticking the option. Click the OK button, the format recovery 

process starts and its progress is shown by a progress-bar. 
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On completion a message box is displayed- “Format Recovery 

Completed. The recovered files and folders, if any available, can 

be viewed by moving to the respective partition and looking for a 

folder named "Format Recover".   Select the desired partition to 

find a folder named Format Recover. This folder will contain other 

folders (names starting with "CNo:") and they will contain the files 

recovered. If all partitions are selected for recovery, the menu 

option "Format Recovery" will be disabled after the completion of 

format recovery.  If the Format recovery process is cancelled or not 

all partitions are selected then the menu option is not disabled 

 

 

Task 27: How can you preview a storage media locally? 
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Solution: Run CyberCheck6.0 

To display the details of storage media connected in the analysis 

machine.Select View|Storage Media Details. Or click on the 

Storage Media Details icon provided in the tool bar. A list box will 

be displayed, listing the details of the fixed storage media available 

in the analysis machine. 
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Carving Files in CyberCheck (In-place carving) 

 

Task 28: How do you initiate carving process from unallocated 

clusters, Disk Slack? 

 

Solution: Click a partition in the left tree. In the table view select 

‘Used Unallocated Clusters’ and Right click it. Select ‘Carve Files’ 

from the context menu. A progress bar will appear in the bottom 

showing the carving progress. After completion, a message box 

will appear showing the carved file details.  

 

 

Task 29: Where can you see the carved files from unallocated 

clusters, Disk Slack? 

 

Solution: The result will be shown by clicking the folder ‘Carved 

from Used Unallocated clusters’ in the left tree view. 
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Task 30: How do you export a carved file? 

 

Solution: Select a carved file and right click it. Select Export from 

the context menu and select the location to which it is exported. 

 

 

 

Task 31: How do you append a carved file to report? 

 

Solution: Select a carved file and right click it. Select ‘Append to 

Report’ from the context menu. 
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Task 32: How do you see the carved files in gallery view? 

 

Solution: Select Gallery tab while viewing the resultant carved 

files. 

 

 

 

 


